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USING THIS MANUAL

This section contains information that helps you understand and use the information contained in
this manual.

Purpose
The ANZ eGate™ VPC Batch Loader is an application facilitating the batched processing of credit
card transactions.

This Batch Loader R2.0 User Manual helps end users to understand the installation and operational
requirements of the Batch Loader application.

The reader is expected to have a firm understanding of ANZ eGate™ and related tools prior to
using the information contained within this manual.

Audience

ANZ eGate™ provides this manual for merchants and their authorized agents. Specifically, the
following personnel should find this manual useful:

e Business owners responsible for delivery of the application

e Technical support personnel

e End users of the application.

Related Documents

This document is intended to be used with reference to various other documents detailing systems
that this application depends upon. The reader is advised to consult the following documents to
gain an in depth understanding of the application:

Document Name Provider

ANZ eGate™ Merchant Administration User Manual ANZ

Other Software Dependencies

The Batch Loader depends upon the following 3rd party software:

Software Version URL

Java Runtime Environment SUN JRE 6 http://java.sun.com/
OR OR

Java Development Kit SUN JDK 6

Furthermore, the application requires connectivity to the internet in order to send transactions to
the Payment Server.
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Where to Get Help
Address: EFTPOS New Zealand Limited
69 Tory Street
PO Box 2457
Wellington
New Zealand

Attn: Integrated Solutions

Email: is@eftpos.co.nz
Telephone: 0800 338 767
Facsimile: 0800 333 311

ESSENTIAL KNOWLEDGE

This section contains background information that the reader is expected to understand prior to
installing and operating the application.

Maybe somewhere in the Doc have a disclaim that this software is provided as is. Please talk to
Tim about legally disturbing the software.

Distribution

The Batch Loader installation package is distributed to merchants who have signed onto the ANZ
eGate™ service, and have a specific requirement for the batched processing of transactions.

NOTE: The Batch Loader installation package must NOT be redistributed without the
prior consent of ANZ National Bank Limited.
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Functional Overview

The following diagram depicts the communication between the Batch Loader and various
components of the ANZ eGate™ service:

MiGS Payment
Server

—s)sanbay pajdAuoug—p
le—soasuodsay paydAioug—

VPC Batch Loader
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T )
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o <
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S S
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CSV Batch File CSV File Report

Figure 1 - Communication between the Batch Loader and the Server

As the Batch Loader communicates with the server via the Payment Client, the Batch Loader must
only use Merchant IDs linked to the keys in the Payment Client.

Pre - requisites

SUN JRE/JDK must be installed prior to the installation of the Batch Loader. Please refer to the
“Related Documents” and “Other Software Dependencies” for further information on obtaining and
installing this software.

Furthermore, a valid Merchant ID must be active on the ANZ eGate™ service, please contact
Payment Service Provider if you have not received this or access to the ANZ eGate™ Merchant
Administration website.
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Two - Step Manual Processing Cycle

VITAL INFORMATION: Merchants operating the Batch Loader application manually must process
transactions in a two-step process:

Validate Only Cycle — this process prescreens the input file for commonly known errors, and
outputs information on which transactions are correctly formatted, and which transactions will
definitely fail. In the Validate Only Cycle, no transactions will be sent to the Payment Server. This
allows the merchant to correct formatting errors. Once the user is happy with a validated input
file, they may proceed to the next step.

NOTE: the application defaults with the validate only option enabled, however the
user may manually skip this step. Validation is highly recommended to reduce rework
on failed transactions.

Processing Cycle — this process will send transactions to the Payment Server. Any transactions
that had failed validation, but had not been corrected, will not be sent to the server.

NOTE: in-depth information on using the application will be detailed in the section
“Using the Batch Loader”.

Automatic Processing Cycle - Automatic Processing will be covered in the Advanced Section of this
manual.

Input and Output File Format

The Batch Loader application processes transaction commands from comma separated value (CSV)
input files. Likewise, it outputs results to CSV output files.

Input and Output File Locations
The Batch Loader application picks up input files from the following subdirectory:

<BATCHHOME>\batchin (by default)

and generates output files in:

<BATCHHOME>\batchout (enforced)

where <BATCHHOME> is the directory in which the application has been installed. The user may

select input files from other directories, however the output files will always be generated in the
“batchout” directory.
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Validate Only Cycle

INPUT FILE . OUTPUT FILES
{batchin) : (batchout)
E sv.test.all.csv
—> Results of ALL txns

(validated and error)

Validate
Cycle

test.app.csv
—» Results of VALIDATED txns
(validated txns only)

csv.test.err.csv
—» ERROR t¢ns copied from
input file.cav

Figure 2 Input and Output File Format Validate Only

In the Validate Only Cycle, users can validate the file, make any adjustments necessary, and
validate the file again. There is no limit on the number of times a file can be validated.

NOTE: the output filenames are prefixed with the input filename. This is to allow easy
identification of results.

Processing Cycle

INPUT FILE
{batchin)

OUTPUT FILES
(batchout)

.all.csv
—> Results of ALL txns
(approved,declined,error)

Process

Cycle e.csv.app.csv
—» Results of APPROVED txns
(approved txns only)

2.csv.dec.csv
—» DECLINED t¢ns copied from
input file.csv

.eIr.csv
—» ERROR txns copied from
input file.cav

: .state
—»  Keeps track of which txns
from file.csv is processed

Figure 3 Input and Output File Format Processing Cycle
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In the Processing Cycle, the file.csv.state file is used to keep track of which lines in the input
file.csv has been processed. Should the process be interrupted, processed transactions will not be
sent again. The program will resume at the first unprocessed transaction.

NOTE: the application keeps track of results and processed transactions via the
unique filename. Once the Processing Cycle has been initiated, the user MUST NOT
CHANGE/DELETE the filenames or contents of the files illustrated above.

The declined file.csv.dec.csv and error file.csv.err.csv files contain declined and error transactions
exactly as they appear in the input file. The user can make a copy of these files, make any
corrections necessary, and reprocess these failed transactions. NOTE: it is recommended that the
user does not change the declined and error output files, but rather make a different copy for
reprocessing. The user can copy these files to the input directory and make modifications there.

WINDOWS INSTALLATION

This section contains information on the installation and general configuration of the Batch Loader.
Installation Package
The Batch Loader is distributed via a package named:

vpcbatch_<version>_ANZ.exe

where <version> is the current version of the application. To initiate the installation process,
doubleclick the installation package:

Browse @@

Look in: | 3 AMNZ eGate_vpe batch_loader -v: Q ? ® =

A
9
My Flecent
Docurments

Desktop

Evpchatch_rz.0_anz

)

My Documents

y
i
"]

My Computer
‘») File name: .vpcbatch_HZD_ANZ b
5 : =
My Network Filez of type: | Programs |

Figure 4 Windows Installation - Installation Package
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Installation Process

The installation program will begin with an “Introduction” screen. Click Next to proceed.

% ANZ VPC BatchlLoader R2.0 IZ rz|

Introduction

o
=

Introduction Installamawhere will guide you through the installation of ANZ VPC
BatchLoader R2.0.

Itis strongly recommended thatyou guit all programs before
cantinuing with this installation.

Click the ‘MWext button to proceed to the next screen. Ifyou want to
change something on a previous screen, click the Previous' hutton.

You may cancel this installation at any time by clicking the 'Cancel’
huttan.

Cancel Frevious

Figure 5 - Windows Installation - Introduction

A “Choose Java Virtual Machine” screen will be displayed. A list of recognised Java Virtual Machines
(JVMs) will be listed.

NOTE: The correct JVM as specified in the section “Other Software Dependencies” is
required.
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Click Next to proceed.

\2 ANZ VPC Batchl oader R2.0 A= 3

Choose Java Virtual Machine

Please Choose a Java WM for Use by the Installed Application
C:\Program Files)Javaljzrel.4.2_04bintjava exe

C:\Program FilestJavaljrel.5.0_13\bin\java.exe

Zi\Program Files)Javaljrel.6.00bin} jaw: !

[ Search Far Others J [ Choose Another.. ]

Cancel FPrewious

Figure 7 - Windows Installation - Choose Java Virtual Machine

A “Choose Install Folder” screen will be displayed. It is recommended that the default folder should
be used. Click Next to proceed.

Y2 ANZ VPC Batchloader R2.0 Al=.3

Choose Install Folder

Where Would You Like to Install?
| Ci\eGatelVPCBatchLoader |

[ Restara Default Folder H Chaoose... ]

Figure 8 - Windows Installation - Choose Install Folder

A "Choose Shortcut Folder” screen will be displayed. It is recommended that the default folder
should be used. Click Next to proceed.
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\2 ANZ VPC Batchl oader R2.0 A= 3

Choose Shortcut Folder

Where would you like to create product icons?

(=) In a new Program Group: |.C\NZ WPC BatchLoader R2.0

D In an existing Program Group:  Accessores
() In the Start Menu

(7 On the Desktop

("3 In the Guick Launch Bar

() Other: |

() Don't create icons

[[] create Icons for &l Users

Prewious

Figure 9 - Windows Installation - Choose Shortcut Folder
A “Pre-Installation Summary” screen will be displayed. Once the user has checked the settings,
click Install to proceed.

Y2 ANZ VPC BatchlLoader R2.0 Al=13

Pre-Installation Summary

¥ Intraduction Please Review the Following Before Continuing:
$ ; Product Name:
AMZ WPC BatchLoader R2.0

Install Folder:
CheGatevwPCBatchLoader

Shortcut Folder:
ChDocuments and Settings\Garellis\vStart
hMenutPrograms\wANZ WPC BatchLoader R2.0

Disk Space Information (for Installation Target):
Reqguired: 2,712,145 bytes
Available: 23,133,990 912 bytes

Cancel Prewious Install

A progress screen will be displayed. Please wait while the application is installed.

Once the installation is complete, an “Install Complete” screen will be displayed. Click Done to
complete the installation process.
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Post - Installation Configuration

All following configurations are done by modifying the ‘BATCHLOADER.properties’ file located in
<batchhome>\classes folder (default C:\EGate\VPCBatchLoader\classes)

Please open this file '‘BATCHLOADER.properties’ by using any text editor, such as notepad or
wordpad.

Installation Patch setting (You might skip this step, if you install the batch load by using default
installation patch.)

Look for ‘BATCHLOADER_ROOT’, and input the correct patch for the Batch Loader.
Examples

BATCHLOADER_ROOT=C:\\EGate\\BatchLoader
Look for ‘MIGS.TARGETURL’
Please mark sure the URL is ‘https://migs.mastercard.com.au/vpcdps’.
MIGS.TARGETURL=https://migs.mastercard.com.au/vpcdps

3. Look for ‘*ACCESSCODE’

Please input the Accesscode you retrieved from Merchant Administration (MA) portal or from your

Bank.

You should also obtain the MA login from your bank.

For detailed information on the settings configurable in the BATCHLOADER.properties
configuration file, please refer to Appendix A.

ANZ eGate™ VPC Batch Loader Manual - March 2008
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USING THE BATCH LOADER

This section contains information on the operation of the Batch Loader application.
Starting the Batch Loader in Windows

As mentioned in a previous section, the Batch Loader can be started via:
Start -> Programs -> MiGS VPC Batchloader R2.0 -> Load

An “ERR-BATCHLOADER" screen will be displayed if there is an error. Please refer to Appendix B.
The Validate Only Cycle

Once the Batch Loader has been successfully started, the main “Loader” screen will be displayed.

ANZ eGate VPC Batch Loader R2.0 9i=1(c3]

ANZ eGate™ |

AMA Configuration

File [v¥] validate Only

I ml
Status Please open a hatch file. | Send File || Stop

Thread 1 | | ReADY
Thread2 | | ReADY
Thread3 | | READY
Thread 4 | | READY
Threads | | READY

View All Results || Approved Declined Error
Pre-Auth/Purchase Transactions 1] 1] 0
Total Pre-Auth/Purchase Walue $0.00 F0.00 | fapprox) F0.00
Refund Transactions o i} i}
Total Refund YWalue $0.00 $0.00 | fapprox) F0.00
Capture Transactions o a o
Total Capture Walue $0.00 $0.00 | fapprox) $0.00
Unknown Transactions 0

The main “Loader” screen is the interface through which the user will carry out the batch
processing task. Notice that the “Batch File” field is currently blank, and that the “Load” button is
disabled.

Batch File Input Directory

Batch files should be placed in the following directory:

<BATCHHOME=>\batchin

This will allow the application to easily locate the batch files to be processed. Although it is not
mandatory for batch files to be placed in this directory, it is highly recommended so that the user
can keep track of all their files.

ANZ eGate™ VPC Batch Loader Manual - March 2008 14



NOTE: batch files must have a unique filename. As detailed in the section “Input and
Output File Locations”, the application keeps results and status information according
to the input filename.

Opening a Batch File

To select a batch file, click on the Open button from the “Main Loader” screen. An example batch
file is included in the installation package. Select the batch file and click the Open button.

B Open |z]
Look In: | batchin - E

E‘| Auto_sampleStandard01.csv
D sample_No_ExpDate.csv

|j‘| sampleCustom01.csv

|j| sampleStandard0i.csv

|j| sampleStandard0?.csv

[} SpeedTest100_7_MIGSTEST_TESTh.csv

File Mame:

Files of Type: |Batch files (*.csv) -

Open Cancel

ANZ eGate™ VPC Batch Loader Manual - March 2008
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Ensuring that “Validate Only” is checked

By default, the Validate Only checkbox is ticked when a batch file is selected. Because this option
is selected, no transactions will be sent to the server; transactions in the batch file will be checked
for common formatting errors.

ANZ eGate VPC Batch Loader R2.0

Frogram Help

ANZ eGate™ | A2

Loader | AMA Configuration

Status Press LOAD to hegin.

File Cyeaatet WPCBatchloaderybatchintsampl eStandardil. csw

Open @Iidme Only

| Send File || Stop

Thread 1
Thread 2
Thread 3
Thread 4
Thread 5

[ Jreor
]
]
—]
[ Jreor

Wiew All Results

Approved

Declined

Error

Pre-Auth/Purchase Transactions
Total Pre-Auth/Purchase WYalue
Refund Transactions

Total Refund Walue

Capture Transactions

Total Capture Walue

Unknown Transactions

$0.00

$0.00

$0.00

$0.00

F0.00

$0.00

{approx

(approx)

(approx)

$0.00

$0.00

$0.00

Notice that the “Batch File” field will display the filename of the selected batch file. Once a batch
file has been selected, the “Load” button is enabled as illustrated above.

ANZ eGate™ VPC Batch Loader Manual - March 2008
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Starting the “Validate Only” Cycle

The validation can be started via the Load button.

ANZ eGate VPC Batch Loader R2.0

Program Help

ANZ eGate™ |

Loader rAMA Configuration |

File CineGatenWPCBatchloaderybatchinysamplestandarddl.csy [v] validate Only
Status Fress LOAD to begin. <| Send File D) Stop
Thread 1 | | REfDY
Thread2 | | ResDY
Thread3 | | ResOY
Thread4 [ | ResDY
Thread5 | | READY
Yiew All Results || Approved Declined Error

Pre-Auth/Purchase Transactions
Total Pre-AuthfPurchase Walue
Refund Transactions

Total Refund Walue

Capture Transactions

Total Capture Walue

Unknown Transactions

$0.00

$0.00

$0.00

F0.00

$0.00

F0.00

tapprax)

(approx)

approx)

Fo.00

$0.00

F0.00

The progress will be displayed while validation is taking place.
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Checking the Results from the “Validate Only” Cycle

Please wait while the application performs validation. Once it is complete, the application will
display “"FINISHED" in the “Status” field. Several results buttons will also be enabled.

ANZ eGate VPC Batch Loader R2.0 (=13

Program Help

ANZ eGate™ |

Loader | AMA Configuration

File CyeGatet WPCBatchloaderybatchintsampleStandarddl. csw [v] ¥alidate Only

Statu | send File || Stop

Thread 1 | | READY
Thread2 | | ResDY
Thread3 [ | RefOY
Thread4 | | ResDY
Threads [ | ReaDY

View All Results || Validated Declined Error

Pre-Auth/Purchase Transactions 19 1] 0
Total Pre-Auth/Purchase Walue $20.50 F0.00 | fapprox) F0.00
Refund Transactions 0 ] 0

Total Refund Walue $0.00 $0.00 | fapprox) F0.00

Capture Transactions o a o

Total Capture Walue $0.00 F0.00 | fapprox) F0.00

Unknovwn Transactions 1]

The View All Results button will display the validation status of all transactions contained in the
input batch file. This includes all validated and error results (file.csv.test.all.csv).

The Validated button will display the validation status of all validated transactions
(file.csv.test.app.csv).

The Error button will display the error transactions exactly as it appears in the input batch file
(file.csv.test.err.csv).

Please refer to Appendix B and C for detailed information on result codes and result information.

The following is an example of the .all.csv file that is displayed when the View All Results button is
pressed.
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Gate\VPCBatchlLoaderibatchout\sampleStandard01.csv.test.all.csv

File

VALIDATED ,Validation
VALIDATED ,Validation
VALIDATED ,Validation
[VALIDATED ,Validation
VALIDATED,Validation
VALIDATED ,Validation
VALIDATED ,Validation
VALIDATED ,Validation
VALIDATED ,Validation
VALIDATED ,Validation
VALIDATED,Validation
VALIDATED ,Validation
[VALIDATED,Validation
VALIDATED ,Validation
VALIDATED ,Validation
VALIDATED,Validation
VALIDATED ,Validation
VALIDATED ,Validation
VALIDATED ,Validation

passed,C, TESTTESAUDALUCTF , AUTH-APF-01, 512345%#####+ 346, 1305, , 100, AUTH-APF-01

paszed, PRCH, TESTTESAUDALUCYF, AUTH-APP-02, 5125345 %*®**** 344 1305, %*% , 100, AUTH-APP-02

passed,C, TESTTESAUDALUCYF , AUTH-APP-03, 12345+ # %5+ 346, 1305, *+%, 100, ATTH-APP-03
passed, PRCH, TESTTESAUDALUCYF, AUTH-APP-04, 512345 %% 5+ 5 %%346, 1305, , 100, AUTH-APP-04
passed,C, TESTTESAUDALUCYF , AUTH-APP-05, 123458+ %45+ 346 , 1305, #+% , 100, ATTH-APP-05
passed, PRCH, TESTTESAUDALUCTF, AUTH-APP-06, 512345 5%+ %% 346, 1305, , 100, AUTH-APP-06
passed,C, TESTTESAUDALUCYF , AUTH-APP-07, 5123458+ #%5+346, 1305, ¥ %%, 100, ATTH-APP-07

pazzed, PRCH, TESTTESAUDALUCYF, AUTH-AFF -0, 5125345 %% ®#®# % ® 346 1305, %%% , 100, AUTH-AFF-035

passed,C, TESTTESAUDALUCYF , AUTH-APP-09, 512345#+###s% 346, 1305, , 100, AUTH-APP-09
passed, PRCH, TESTTESAUDALUCYF, AUTH-APP-10, 512345+ %%+ 5 %4346, 1305, , 100, AUTH-APP-10
passed,C, TESTTESAUDALUCYF, AUTH-DEC-01, 512345% %+ ### %346, 1305, , 105, AUTH-DEC-01

paszed, PRCH, TEATTESAUDALUCYF, AUTH-DEC-02, 512545+ ***+* 348 1305, %*+% 110, AUTH-DEC-02

pazzed, 0, TESTTESAUDALTICYF, AUTH-DEC-03, S12345%*##%® %346 1305, %%+ 133, AUTH-DEC-03
paszed, PRCH, TESTTESAUDALUCYF, AUTH-DEC-04, S 12345*#®## %% 345 1305, 151, AUTH-DEC-04
paszed, C, TESTTESAUDALTICYF, AUTH-DEC-05, 5123 45%****** 344 1305, *** 151, AUTH-DEC-05

paszed, PRCH, TESTTESAUDALUCYF, AUTH-ERR-01, 5125345 *®#*%* 345 15305, %**%, 100, AUTH-ERR-01]

passed,C, TESTTESAUDALUCYF , AUTH-ERR-02, 123455+ 454346 1305, ##+% 100, AUTH-ERR-02

pazzed, PRCH, TEZTTEZAUDALUCYF, AUTH-ERR-03, 512345 #®##% % 348 1305, %%%%, 100, AUTH-ERR-03

passed,C, TESTTESAUDALUCYF , AUTH-ERR-04, 51 2345%## # %5 %346 , 1305, ##%% , 100, AUTH-ERR-04

-------------------- END OF FILE-----—mmmmmmm e -

L]

[4]

Amending the Input Batch File

The user should take note of any error transactions, and make any modifications necessary.
Because this is the “Validate Only” cycle, the user may make modifications to the original input
batch file.

The user is encouraged to validate the input batch file until the batch file is deemed fit for the
“Processing” cycle.

To repeat the “Validate Only” cycle after making modifications, the user should ensure that the
Validate Only option is selected, and click on the Load button to revalidate.

NOTE: the most common source of validation errors are fields that are too long / too
short, or fields that contain invalid information (for example a card number failing
MOD10 check).

ANZ eGate™ VPC Batch Loader Manual - March 2008
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The AMA Configuration Screen

If the input batch file contains transactions, such Capture and Refund, requiring “Advanced

Merchant Administration” usernames and passwords, they can be configured in the "AMA

Configuration” screen.

The AMA User can be created by login to Merchant Administration Portal. Please refer to MA

manual for more information.

B ANZ eGate VPC Batch Loader R2.0

FEX

Program Help

Loader | AMA Configuration

ANZ eGate™ |

The Merchant ID and Username can be preset from your BATCHLOADER.properties configuration file.
Merchant ID AlMA Username Password Confirm
1 |TESTMERCHANT1 | |user1 | |
2 [TESTMERCHANT2 | user? | |
32 |TESTMERCHANT3 | |user3 | |
4 |TESTMERCHANT4 | |user4 | |
5 |TESTMERCHANT5 | |user5 | |

Up to five (5) AMA usernames/passwords can be configured.

The Processing Cycle

Once the user has validated the batch file, they may begin the “Processing” cycle.

ANZ eGate™ VPC Batch Loader Manual - March 2008
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Ensuring that “Validate Only” is cleared

To start the “Processing” cycle, ensure that the “Validate Only” checkbox is cleared as illustrated

below.

ANZ eGate™ VPC Batch Loader Manual - March 2008

ANY eGate VPC Batch Loader R2.0

Program Help

Loader | AMA Configuration

ANZ eGate™ |

Status  FINISHED

File CyeGatet WPCBatchloaderybatchintsampleStandarddl. csw

| Send File ||

Stop

Thread 1

 reor
ke

Thread 2

Thread 3
Thread 4
Thread 5

o
e
e

Yiew All Results ||

Validated

Declined

Error

Pre-Auth/Purchase Transactions
Total Pre-Auth/Purchase Walue
Refund Transactions

Total Refund Walue

Capture Transactions

Total Capture Walue

Unknown Transactions

14
$20.50

$0.00

$0.00

F0.00

$0.00

F0.00

lapprox)

(approx)

approx)

F0.00

$0.00

F0.00

NOTE: by clearing the “Validate Only” checkbox, transactions will be sent to the
server when the “Load” button is pressed.
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Starting the "“Processing” Cycle

The processing can be started via the Send File button.

ANY eGate VPC Batch Loader R2.0
Program Help

ANZ eGate™ |

Loader | AMA Configuration

File CyeGatet WPCBatchloaderybatchintsampleStandarddl. csw |:|\I"a.|id__a.te Only

Status FINISHED | Send File | Stop

Thread 1 | | READY
Thread2 | | ResDY
Thread3 [ | RefOY
Thread4 | | ResDY
Threads [ | ReaDY

View All Results || Validated Declined Error
Pre-Auth/Purchase Transactions 19 1] 0
Total Pre-Auth/Purchase Walue $20.50 F0.00 | fapprox) F0.00
Refund Transactions 0 ] 0
Total Refund Walue $0.00 $0.00 | fapprox) F0.00
Capture Transactions o a o
Total Capture Walue $0.00 F0.00 | fapprox) F0.00
Unknovwn Transactions 1]

A confirmation popup for the start of the “Processing” cycle will appear. Click Yes to proceed or No
to cancel processing.

CONFIRMATION |

L ] The "FProcessing Cycle” will benin and transactions will he sent to the serer.

= Flease ensure that vou are satisfied with the results during the "alidate Qnly
Cyele”. Ifthe hatch contains refunds, please also ensure that you have configured
the AMA Username and passwoard in the "AMA Configuration” screen. Are you sure

you want to proceed?

Waiting for the “Processing” Cycle to Finish

Please wait while the application performs processing. The total time is dependent on the size of
the batch file, the speed of the computer, the speed of the internet connection, and the
authorisation time taken for each transaction.

ANZ eGate™ VPC Batch Loader Manual - March 2008

22



The processing can be stopped via the Stop button, the File -> Exit menu item, or the X at the top
right corner of the application. If the processing needs to be stopped, please wait patiently while
the application finishes off transactions that have already been sent to the server.

NOTE: the application cannot be closed while a batch file is being processed. If the
File > Exit menu item, or the X is pressed while a batch is being processed, this will
be equivalent to pressing the Stop button. To close the application press the File >
Exit menu item or the X while batch processing has finished or has stopped.

Checking the Results from the “Processing” Cycle

Once the “Processing” cycle is complete, the application will display “FINISHED" in the “Status”
field. Several results buttons will also be enabled.

ANZ eGate VPC Batch Loader R2.0 9(i=(E3]

ANZ eGate™ |

Loader | AMA Configuration

File CiyemateWPCBatchLoaderybatchinysampleStandardil. csw [ walidate Only

Status | send File | 5t0p

Thread 1 | | REfDY
Thread2 | | ResDY
Thread 3 [ | ResDY
Thread 4 | | READY
Thread5 | | READY

Yiew All Results || Approved Declined Error

Pre-Auth/Purchase Transactions 0 u] 14
Total Pre-Auth/Purchase Walue $0.00 F0.00 | fapprox) $20.50
Refund Transactions i} o o

Total Refund Walue $0.00 F0.00 | (approx) $0.00

Capture Transactions o a 1]

Total Capture Walue $0.00 $0.00 | fapprox) F0.00

Unknown Transactions 0

The View All Results button will display the results of all transactions. This includes all approved,
declined, and error results (file.csv.all.csv).

The Approved button will display the results of all approved transactions (file.csv.app.csv).

The Declined button will display the declined transactions exactly as it appears in the input batch
file (file.csv.dec.csv).

The Error button will display the error transactions exactly as it appears in the input batch file
(file.csv.err.csv).

An extra state file (file.csv.state) contains the information on which lines of the input batch file has
been processed. This file is for the internal use of the application only. PLEASE DO NOT EDIT OR
REMOVE THIS FILE, this is especially important if the processing was stopped before it was

finished, as this file allows the application to resume processing at the last unprocessed

transaction.
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Business Processes for Declined and Error Transactions

The declined (file.csv.dec.csv) and error (file.csv.err.csv) files contain transactions copied from the
input batch file. The exact reason for the decline/error should be crosschecked with the results file
(file.csv.all.csv) and a business decision be made whether to correct and reprocess these
transactions.

DO NOT MODIFY THESE FILES DIRECTLY — these files can be copied back into the input directory
as a new batch file. Please rename it to a unique batch filename.
Refunding Transactions

The approved results file file.csv.app.csv contains the necessary information for processing
refunds. DO NOT MODIFY THIS FILE DIRECTLY - this file can be copied back into the input
directory as a new batch file. Please rename it to a unique batch filename.

The "TXNTYPE” field can be changed from a charge to a refund, while the “TRANSACTIONNQO” can
be used. All other irrelevant fields should be removed to conform to the refunds format (see
Appendix C).

UN-INSTALLATION

This section contains information on the un-installation of the Batch Loader application.

Before Un-installing the Batch Loader

NOTE: before uninstalling the Batch Loader please ensure that the batchin and
batchout directories (input batch files, and output results) are backed up in a safe
location.

Uninstalling the Batch Loader in Windows

The Batch Loader can be uninstalled via:

Start—> Programs -» BatchLoader-> Uninstall
Follow the onscreen instructions to uninstall the application.

ADVANCED FUNCTIONS

This section contains information on the advanced functions and settings of the Batch Loader
application.

Before users attempt to utilise these advance function they should have a good understanding of
how the Batch Loader functions and the input/output formats.

Automating Batch Loader

By starting the Batch Loader with Load_Auto.exe the Batch Loader will search through the batchin
and process all files that starts with certain pattern (default is “Auto”).

This pattern can be changed/defined in
\BatchLoader\classes\BATCHLOADER.properties
in the line

INPUT_PATTERN=Auto

Next is to add running Load_Auto.exe as a windows scheduled task, please navigate to:
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Start > All Programs > Accessory > System Tools > Scheduled Tasks
Click on Add Scheduled Task

Click on Next

Click on Browse

Browse to the Batch Loader folder and select Load_Auto.exe

Select desired frequency and time.

In the log directory there will be a log file called autotask.log which will have details on the
automated tasks.

For example:

Wed Mar 15 17:40:45 EST 2006

ROOTDIR = C:\MiGS\BatchLoader

INPUT_DIRECTORY = C:\MiGS\BatchLoader\batchin
OUTPUT_DIRECTORY = C:\MiGS\BatchLoader\batchout
INPUT_PATTERN = Auto

VALIDATE_ONLY = false

Ready to process 1 input files

... Auto Processing
C:\MiGS\BatchLoader\batchin\Auto_sampleStandard01.csv
... done #0

Finished auto processing

Operating in the Background The Batch Loader can be ran hidden automatically.
Right click on Load_Auto.exe
Select Properties

In the “Target:” field, delete the word “show” at the end.

Next time the Batch Loader is ran from Load_Auto.exe it will start processing without showing its
window.

Custom input directory

You can define your own input directory in
\BatchLoader\classes\BATCHLOADER.properties
by removing the # infront of the line

INPUT_DIRECTORY=C:\\MiGS\\BatchLoader\\MERCHANT_DEFINED
Recurring Payments

User may send an empty expiry date field if optional expiry date is activated.
For example, a purchase transaction line will be:

C,MERCHANTID,MERCHREF,5123456789012346,,123,500,0RDERINF
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To activate the optional expiry date, users will have to open the "BATCHLOADER. properties" file
in the classes folder; And uncomment the line: (take away the #)

#RECURPAY_CARDEXP=0ptional

During validation, if no Exp Date is specified or it is all "spaces", it will pass validation. If the exp
date has anything other than spaces, validation will still check for its formatting as per non-
recurring payments.

NOTE: The merchant account has to be set-up by your Payment Service Provider and
there maybe special conditions associated with having the functionality. Please
consult your Payment Service Provider for further information.
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APPENDIX A

BATCHLOADER.properties

Below is an example listing for the configuration file.

HEHHHBRH AR BHH AR BB AR BB HH BB H AR B HH AR H AR B HHH BB H AR B H AR BB H AR B HHHH
HEHH#HBRAHHBHHHRRHHHY

#

#

#

#

Copyright 2007 MasterCard International

BATCHLOADER.properties - MiGS VPC BatchLoader Configuration File

Lines that are  prefixed with "#" are comments lines.
Lines that are NOT prefixed with "#" are settings lines.

Lines that appear more than once will take the value furthest down in file.

HEHHHB BB AR BRH AR BB HH BB AR RH AR B HRHHRBH AR BB HH BB AR BB AR BB H AR R HHHY
HEHHHBRHHHRBEHHRBHHHY

#

#

B3

BATCHLOADER_ROQT
Must be set to the batch installation directory. Note that Windows

directories are separated by double backslash \\ and there is no trailing \\

Examples

BATCHLOADER_ROOT=C:\\eGate\\BatchLoader

BATCHLOADER_ROOT=\\eGate\\VPCBatchLoader

#

#

#

#

INPUT_DIRECTORY

User Defined Input Directory, default is "\\BatchLoader\\batchin"

#INPUT_DIRECTORY=C:\\eGate\\VPCBatchLoader\\MERCHANT_DEFINED

#

#

RECURPAY_CARDEXP
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# Uncomment the line below and the batch loader will not check the existence
# of the card expiry date. (For recurring payments)

#

RECURPAY_CARDEXP=0Optional

#

B3

INPUT_PATTERN

H

Only batch filenames that starts with the defined INPUT_PATTERN will execute

B3

when the BatchLoader is in Auto Mode.

INPUT_PATTERN=Auto

#

# BATCHLOADER_DOFORMAT

H

Must be set to the input file format. Refer to documentation for details.

H

Examples
#  BATCHLOADER_DOFORMAT=BATCHLINECUSTOM1

# BATCHLOADER _DOFORMAT=BATCHLINESTANDARD

#
BATCHLOADER_DOFORMAT=BATCHLINESTANDARD
#BATCHLOADER_DOFORMAT=BATCHLINECUSTOM1

#

# BATCHLOADER_CCMASK16

# Masking format for 16 digit card numbers in the ".out.csv" results file
#

# Examples

# (DEFAULT) Mask ALL digits

# 0.4 Show only the last 4 digits

# 6.3  Show only the first 6 and the last 3 digits
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# 6.4 Show only the first 6 and the last 4 digits
# NONE No masking, display all digits

#

BATCHLOADER_CCMASK=0.4

#

# AMA Username and Password Configuration

# Preset the AMA merchant ID and usernames for refunds processing
#

# Examples

# BATCHLOADER_AMA_MERCHANT1_ID=TESTMERCHANT1

# BATCHLOADER_AMA_MERCHANT1_USER=userl

#

BATCHLOADER_AMA_MERCHANT1_ID=TESTMERCHANT1
BATCHLOADER_AMA_MERCHANT1_USER=AMA
BATCHLOADER_AMA_MERCHANT1_PASS=password123
BATCHLOADER_AMA_MERCHANT2_ID=TESTMERCHANT2
BATCHLOADER_AMA_MERCHANT2_USER=user2
BATCHLOADER_AMA_MERCHANT3_ID=TESTMERCHANT3
BATCHLOADER_AMA_MERCHANT3_USER=user3
BATCHLOADER_AMA_MERCHANT4_ID=TESTMERCHANT4
BATCHLOADER_AMA_MERCHANT4_USER=user4
BATCHLOADER_AMA_MERCHANTS5_ID=TESTMERCHANT5
BATCHLOADER_AMA_MERCHANTS5_USER=user5

HEBHH BB A AR BEH AR BB HH B AR AR H AR B HHH BB H AR B AR R BB HH R BB AR B R HHRRHHH
# THE FOLLOWING FIELDS MUST NOT BE CHANGED

HERHHBRH AR BEH AR BB AR BB H AR H AR BB HH BB H AR B HHH BB H AR B H AR B HHRRHHH
BATCHLOADER_ECHO=BATCHLOADER_ECHO

BATCHLOADER_NAME=MiGS VPC Batch Loader
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BATCHLOADER_VERSION=R2.0
HRHABHBABHBRBRBHHRHBHBHBHBABHRBRBRHBRHBH B AR R B RBRBRBHHRHRHBHBHRH
# UNUSED SETTINGS
HRHABHBABHBRBRBRHRHBHBHBHBAB R R B R B RHBHB AR R B RBRBRBHHRHRHBHBHRH
#BATCHLOADER_COMPILATION=WIN32

#--- LOGGING

#--- WARNING: DO NOT CHANGE THESE VALUES AS THIS MAY LEAD TO LOGGING FAILURE.
log4j.rootCategory = DEBUG, MIGSAPPENDER
log4j.appender.MIGSAPPENDER=o0rg.apache.log4j.ConsoleAppender
#log4j.appender.MIGSAPPENDER=o0rg.apache.log4j.DailyRollingFileAppender
log4j.appender.MIGSAPPENDER.layout=org.apache.log4j.PatternLayout

log4j.appender.MIGSAPPENDER.layout.ConversionPattern=%d{yyyy-MM-dd HH:mm:ss.SSS} %-5p
%c{1} Yom%n

#

# TARGET URL
# The VPC Batchloader no longer relies on the Payment Client to point to the
# desired URL. This configuration defines where you are sending the batch transactions

#

#MIGS.TARGETURL=https://
MIGS.TARGETURL=https://migs.mastercard.com.au/vpcdps

#

# ACCESSCODE
# Every MerchantID will have their unique Access Code. It can be retrieved from

# your Merchant Administration Portal.

# Examples
# ACCESSCODE=A605VBD4

#

ACCESSCODE=<your Accesscode here>
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APPENDIX B

This section contains detailed information on RESULTCODE's displayed by the ANZ eGate™ Batch
Loader application.

ERR-BATCHLOADER (BatchLoader Configuration Errors)

ERRBATCHLOADER error messages typically depict configuration errors of the application. With the
exception of LO00 and L001, these errors will prevent the application from processing the batch
file.

INFO DESCRIPTION / RESOLUTION

B00O Could not find the Payment Client. Please check the “lax.class.path”
setting in the Load.lax file, or check your CLASSPATH environment
variable.

B0O1 BATCHLOADER.properties configuration problem

B002 A lock file indicates that the application is already running. Only one
instance of the Batch Loader can run at any one time. The lock file may
have been left behind by a previous crash. If you are 100% sure no other
instances of the Batch Loader is running, you may remove the
BATCHLOADER.lock file from the “log” directory and restart the
application.

B003 Unable to create “.state” file. Please check that the files in “batchout” are
not write-protected, and that you have read/write access to the
“batchout” directory.

B004 There is a problem with the selected batch file. Please check that the file
exists, and that you have read access to the file, and that it is a
supported batch file type.

B005 There is a problem with the selected batch file. Please check that the file
exists, and that you have read access to the file, and that it is a
supported batch file type.

B006 Unable to create “.all.csv” file. Please check that the files in “batchout”
are not writeprotected, and that you have read/write access to the
“batchout” directory.

B007 Unable to create “.app.csv” file. Please check that the files in “batchout”
are not write-protected, and that you have read/write access to the
“batchout” directory.

B008 Unable to create “.dec.csv” file. Please check that the files in “batchout”
are not write-protected, and that you have read/write access to the
“batchout” directory.

B009 Unable to create “.err.csv” file. Please check that the files in “batchout”
are not write-protected, and that you have read/write access to the
“batchout” directory.

LO00 No AMA username specified for this merchant ID. This is returned in the
RESULTCODE and RESULTINFO field during validation or processing.
Please configure the appropriate MerchantID/username/password in the
AMA Configuration screen.

LO01 Invalid BATCHLOADER_DOFORMAT specified in the configuration file
BATCHLOADER.properties. This is returned in the RESULTCODE and
RESULTINFO field during validation or processing. Please ensure that a
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correct value has been configured, and close and restart the application.

ERR-RECORD (Batch File Record Errors)

ERRRECORD error messages indicate formatting errors in a particular
transaction line in the input batch file.

During the “Validate Only” cycle, validated transactions will be marked as “VALIDATED", otherwise
the suitable ERRRECORD will be recorded.

During the “Processing” cycle, all transactions marked with ERR-RECORD will be stopped by the
application and will not be sent to the server.

INFO DESCRIPTION / RESOLUTION

R0O0O Blank line — indicates a blank line in the batch file.

R0O10 Input TXNTYPE is invalid. Check the error message for details.

RO11 Input MERCHANTID is invalid. Check the error message for details.

RO12 Input MERCHTXNREF is invalid. Check the error message for details.

R0O13 Input CARDNUM is invalid. Check the error message for details.

R014 Input CARDEXP is invalid. Check the error message for details.

RO15 Input CARDCSC is invalid. Check the error message for details.

RO16 Input AMOUNT is invalid. Check the error message for details.

RO17 Input ORDERINFO is invalid. Check the error message for details.

R0O18 Input TRANSACTIONNO is invalid. Check the error message for details.

ERR-PC (Payment Client Errors)

ERRPC error messages will only occur during the “Processing” cycle. ERRPC messages indicate that
the formatting of the particular transaction line has been validated, and has been passed to the
Payment Client, however an error has occurred at the Payment Client. Typical errors include non-
existent MERCHANTIDs, internet connection errors, amongst others.

Please check the Payment Client documentation for a full listing of
Payment Client Errors.

APPROVED / DECLINED

Transactions that have successfully reached the authorisation process will have a RESULTCODE of
APPROVED or DECLINED.

RESULTCODE DESCRIPTION

Transaction has gone through authorisation and has been

APPROVED
approved.

Transaction has gone through authorisation and has been

DECLINED declined.
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APPENDIX C

This section contains information on the input file formats supported by the Batch Loader
application.

BATCHLINESTANDARD

The input file format is specified in the BATCHLOADER.properties configuration file. To use the
“"BATCHLINESTANDARD” file format, the following must be configured:

BATCHLOADER _DOFORMAT=BATCHLINESTANDARD

BATCHLINESTANDARD - Charge — Input Format

# | INPUT FIELD REQUIRED | MIN MAX COMMENTS
CHARS | CHARS
1 | TXNTYPE Y 1 1 Must be “C" for MOTO transactions.
2 | MERCHANTID Y 1 16 Provided merchant ID.
3 | MERCHTXNREF N o 40 Merchant generated unique

reference.

Card number to be charged.

4 | CARDNUM Y 13 19 BatchLoader will do MOD10 check.

5 | CARDEXP v 4 4 I;o:n;z;t YYMM. MM is checked to be

6 | CARDCSC N ~ 4 Card Security Code (CVC2/CVV2).

2 | AMOUNT Y 1 10 In CENTS (e.g. $1 = 100). Must not
be <= 0.

8 | ORDERINFO Y 1 34 Merchant generated reference.

# OUTPUT FIELD COMMENTS

1 RESULTCODE Result of the transaction.

2 RESULTINFO Detailed information of the results.

3 TXNTYPE same as input

4 MERCHANTID same as input

5 MERCHTXNREF same as input

6 CARDNUM same as input (may be masked if

configured).

7 CARDEXP same as input

8 CARDCSC always masked

9 AMOUNT same as input

10 ORDERINFO same as input

11 QSIRESPCODE Receipt QSI Response Code

12 QSIRESPCODEDESC Receipt QSI Response Code Description
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13 AMOUNT Receipt Authorized Amount

14 RECEIPTNO Receipt Receipt Number

15 ACQRESPCODE Receipt Acquirer Response Code
16 AUTHORIZEID Receipt Authorization ID

17 BATCHNO Receipt Settlement Batch Number
18 TRANSACTIONNO Receipt Shopping Transaction No
19 CARDTYPE Receipt Recognized Card Type

*Note: error transactions (that are not sent to the server) may not contain receipt fields 1119.
BATCHLINESTANDARD - Refund — Input Format

# | INPUT FIELD REQUIRED | MIN MAX COMMENTS
CHARS | CHARS

TXNTYPE Y 1 1 Must be_“R" for refund
transactions.

MERCHANTID Y 1 16 Provided merchant ID.

MERCHTXNREF N o 40 Merchant generated unique
reference.

TRANSACTIONNO | Y 1 19 Shoppmg Transaction No_ from a
previous Charge transaction.

AMOUNT v 1 34 In CENTS (e.g. $1 = 100). Must
not be <= 0.

BATCHLINESTANDARD — Refund — Output Format

# | OUTPUT FIELD COMMENTS

1 RESULTCODE Result of the transaction.

2 RESULTINFO Detailed information of the results.
3 TXNTYPE same as input

4 MERCHANTID same as input

5 MERCHTXNREF same as input

6 TRANSACTIONNO same as input

7 AMOUNT same as input

8 BLANK blank field

9 BLANK blank field

10 | BLANK blank field

11 | QSIRESPCODE Receipt QSI Response Code

12 | QSIRESPCODEDESC | Receipt QSI Response Code Description
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13 | BLANK blank field

14 | RECEIPTNO Receipt Receipt Number

15 | ACQRESPCODE Receipt Acquirer Response Code
16 | AUTHORIZEID Receipt Authorization ID

17 | BATCHNO Receipt Settlement Batch Number
18 | TRANSACTIONNO Receipt Financial Transaction No
19 | BLANK blank field

*Note: error transactions (that are not sent to the server) may not contain receipt fields 1119.

BATCHLINESTANDARD — Example

A sample batch file is supplied with the Batch Loader. The following is an example of the
BATCHLINESTANDARD charge input format.
C, TESTTESAUDALUCYF, MERCHTXNREF01, 5123456789012346,0504,123,100, ORDERINFOO1

C, TESTTESAUDALUCYF, MERCHTXNREF02, 4005550000000001,0504,1234,100, ORDERINFO02
C, TESTTESAUDALUCYF, MERCHTXNREFO03, 5123456789012346,0504,123,100, ORDERINFO03
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